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Safety Notice: Only qualified personnel should attempt the start-up
procedure or troubleshoot this equipment.

This equipment may be connected to other machines that have rotating parts or parts that are
controlled by this equipment.  Improper use can cause serious or fatal injury.  Only qualified
personnel should attempt to start-up, program or troubleshoot this equipment.

Precautions:

 WARNING: Do not touch any circuit board, power device
or electrical connection before you first
ensure that no high voltage present at  this
equipment or other equipment to which it is
connected.  Electrical shock can cause
serious or fatal injury.  Only qualified
personnel should attempt to start-up,
program or troubleshoot this equipment.

 WARNING: Be sure that you are completely familiar with
the safe operation of this equipment.  This
equipment may be connected to other
machines that have rotating parts or parts
that are controlled by this equipment.
Improper use can cause serious or fatal
injury.   Only qualified personnel should
attempt to program, start-up or troubleshoot
this equipment.

 WARNING: Be sure that you are completely familiar with
the safe programming of this equipment.
This equipment may be connected to other
machines that have rotating parts or parts
that are controlled by this equipment.
Improper programming of this equipment can
cause serious or fatal injury.  Only qualified
personnel should attempt to program, start-
up or troubleshoot this equipment.

 WARNING: Be sure all wiring complies with the National
Electrical Code and all regional and local
codes.  Improper wiring may result in unsafe
conditions.
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 WARNING: The stop input to this equipment should not
be used as the single means of achieving a
safety critical stop.  Drive disable, motor
disconnect, motor brake and other means
should be used as appropriate.  Only qualified
personnel should attempt to program, start-
up or troubleshoot this equipment.

WARNING: Improper operation or programming of the
control may cause violent motion of the
motor shaft and driven equipment.  Be certain
that unexpected motor shaft movement will
not cause injury to personnel or damage to
equipment.  Peak torque of several times the
rated motor torque can occur during control
failure.

 WARNING: The motor shaft will rotate during the homing
procedure.  Be certain that unexpected motor
shaft movement will not cause injury to
personnel or damage to equipment.

 CAUTION: To prevent equipment damage, be certain that
the input power has correctly sized protective
devices installed.

 CAUTION: To prevent equipment damage, be certain that
input and output signals are powered and
referenced correctly.

 CAUTION: To ensure reliable performance of this
equipment be certain that all signals to/from
the controller are shielded correctly.
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Manual Revision History
Issue Date BOCL Reference Comments
2.0 Jan 2000 UM00533-000 • First draft
2.1 August 2000 UM00533-001 • For Mint WorkBench v4.2
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1. Introduction

1
◊ This chapter provides an overview of the comprehensive

Mint WorkBench features
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1.1 The Mint WorkBench

Figure 1: Mint WorkBench

The Mint WorkBench is part of the Baldor Motion Toolkit.  The Mint WorkBench features include:
• Configuration Tools.
• Terminal Emulator
• An editor for Program Buffer and Configuration Buffer with file upload/download.
• Routines for capturing and viewing velocity or following error profiles on your drive.
• A Protected Comms Protocol watch window.
• Squash. A utility saving program buffer space by abbreviating source code.
• Mint Keyword Lookup.
• Serial Test.
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• Terminal only  for communication with Eurosystem.
Full details can be found in section 2.

1.2 Key to Icons

✎ The pencil indicates that you might wish to write particular information down on the note
pages provided at the back of this manual, or somewhere convenient to you.

[ ] Right-angle brackets denote a key that needs to be pressed, for example:
[Ctrl]+[E] indicates that you should type Ctrl and E at the same

time.

The following chapter provides an overview of the Mint WorkBench features.
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2. Mint™ WorkBench

2
The Mint™ WorkBench is a 32 bit Windows front end for use with
Windows 95, Windows 98 and Windows NT.  Features include full
screen syntax highlighting editor, terminal window and tuning
screens.  The chapter covers:

◊ Installation of the WorkBench
◊ Overview of the WorkBench features
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The Mint WorkBench is a 32 bit Windows front end designed for use with a number of Mint v4
based products.  The WorkBench has the following features:

• Terminal facility to communicate with a drive.
• Editor for program and configuration files.  The editor has color syntax highlighting.
• Quick watch window allowing the viewing of up to 4 data values including axis position,

following error and input status.
• CAN Window for monitoring CANopen and Baldor CAN networks.
• Data capture and tuning facility.
• Mint Keyword Lookup.
• Serial Test.
• Terminal only for communication with Eurosystem.

2.1 Installation Requirements
The Mint WorkBench is supplied on CD-ROM as part of the Baldor Motion Toolkit.
In order to install the Mint WorkBench, the PC must conform to the minimum requirements:

Processor: Intel Pentium
Minimum RAM: 16 Mbyte

Hard Disk Space: 10 Mbytes
CD-ROM: Required

Screen: 800 x 600 (minimum)
Operating System: Windows 95, Windows 98 or Windows NT

Recommended: Intel Pentium, 32 Mb RAM, 133 MHz, 40MB hard disk space free.

2.2 Installing the Mint™ WorkBench
To install the Mint WorkBench, insert the Baldor Motion Toolkit CD-ROM into the PC CD-ROM
device.  The setup wizard will automatically run, guiding you through the installation process.   If the
setup does not automatically start, either install the Microsoft Internet Explorer 5 browser (IE5) on
the CD-ROM, or run the WorkBench installation program directly.
IE5 is installed by selecting Run from the Start menu and entering:

D:\IE5\ie5setup

If the setup wizard does not automatically start after installing IE5, WorkBench may be manually
installed by selecting Run from the Start menu and entering:

D:\Mint v4\Installation\Mint WorkBench\setup

(The instructions above assume D: is the CD-ROM.)
The on-screen instructions should be followed.
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The Set-up Wizard copies the WorkBench files to appropriate directories on the hard disk, adding
Mint WorkBench as an option on the start menu.  The drive, directory and Start Menu folder are
user-configurable.
The default directory is C:\Program Files\Baldor\Mint v4\Mint WorkBench, and the default
program folder is Start, Programs, Mint v4.

2.3 Starting the Mint™ WorkBench
It is important that a controller is powered up and connected to the PC before starting the Mint
WorkBench.
To start WorkBench from Windows Start menu, select Programs, Mint v4, Mint WorkBench.
(Alternatively select Mint WorkBench from the folder the WorkBench was installed in, if the
default program folder was rejected during installation.)
The WorkBench behavior on starting up for the very first time is dependent on the controller
attached.  This is covered in detail in the appropriate controller manual.
In the absence of an operational NextMove PCI, the WorkBench window will open, along with the
Select Controller Window.  The screen will show something similar to this:



Mint WorkBench User Guide

8 MN1283  08.2000   

Figure 2: Start-up WorkBench window and Select Controller window

2.4 Selecting a Controller
Before starting Mint WorkBench, it is important that the controller is connected to the PC and
powered up.
WorkBench must be configured for use with the selected controller the first time it is used.
When first opened, the WorkBench will open and display a dialog box similar to the one shown in
Figure 3.  All connected controllers should be shown in the Window.  Serial Controllers missing
from the window must have their connections checked before power cycling and selecting the
Rescan button.  Other controllers must have their connections and device drivers checked before
selecting the Rescan button once again.
If the Mint WorkBench is successfully running, the controller selection box can be opened from the
Tools, Select Controller menu.
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Figure 3: Select Controller window

The Select Controller combo boxes allow (from top to bottom):
• Selection of controller type
• Controller address/Card number
• Serial port selection for scanning
according to the controller type.

The Serial Port Selection is used to optimize the select controller dialog during serial port scanning.
The options are:
• Scan Serial Ports
• Do Not scan Serial Ports
• Only scan COMx (where x is an available serial port)

The Terminal Only button should only be used for diagnostics/debugging.

The Terminal Only button displays:
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The available serial ports are listed along with permissible port speeds.
In this mode the Mint WorkBench functions simply as a dumb terminal and additional functionality
is disabled.

Figure 4 shows the appearance of the WorkBench once a controller has been selected for the first
time.

Figure 4: Default WorkBench window with NextMove PCI selected
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The toolbars can be dragged and docked in different locations in the WorkBench window.  Their
positions are saved when the WorkBench exits, and restored when it restarts.

2.5 WorkBench Toolbars
The Mint WorkBench utilizes toolbars to provide immediate access to commonly used WorkBench
functions.  The are three toolbars:
• Main Toolbar
• Motion Toolbar
• Macro Toolbar
These toolbars may be moved and docked on the sides of the WorkBench window to suit user
preference.  To move a toolbar:
• Click the gripper bar and drag toolbar to new location.
The toolbar positions are stored on the PC when the WorkBench is closed, and restored when
opened.

2.5.1 Navigating the Main Toolbar

Figure 4: Main Toolbar

Many of the tools in WorkBench can be launched from the main toolbar.  The tools are described in
more detail later in the manual.

Reset the controller  (not available on MintDrive).

Save File

Print File

Cut (see 2.9 Editor)

Copy
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Paste

Undo

Toggle the QuickWatch window on/off.

Toggle the CAN window on/off.

Upload File: If an editor is selected, the editor file will be uploaded into it.  Otherwise a
dialog box will prompt for the file to upload.

.
Download File: If an editor is selected, the editor file will be downloaded.  Otherwise a

dialog box will prompt for the file to download

Run: Send Mint Run command

Break: Send Mint Break ([Ctrl] + [E]) command.

Toggle the DPR Watch Window on/off (applies only to NextMove PC and PCI).

Terminal: For communication with the Mint command line.

Copy Drive Tuning Parameters: Parameters copied to the Windows clipboard (Currently
only available on MintDrive.)

View Digital Inputs and Outputs.

About Box: Display program information, version number and copyright information.
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2.5.2 Motion Toolbar
Using the motion toolbar, it is possible to enable a motor to be jogged.  This can be useful for testing
the system.
The axis number is selected using the Axis drop down.  The other buttons then control the jogging
action.  Finally, any error conditions are reported numerically on the toolbar.  Clicking on the error
will display a dialog box giving more information about the error.

Figure 5: Motion Toolbar

The Jog Speed relies on the present acceleration, deceleration and scale values of Mint.  If you wish
to scale to revs for example, then the terminal window needs to be opened and the following typed at
the command line:

SCALE = 4096

This assumes a 12 bit resolver or a 1024 line encoder.
With the scale factor set, the jog speed will be in revolutions per second.  It is recommended that
small values are used and steadily increased until motion is seen on the motor.
Before using the Jog facility, ensure that the motor is first tuned correctly.  Tuning is covered in:
• MintDrive Installation Manual MN1274
• NextMove BX Installation Manual MN1258
• NextMove PCI Installation Manual MN1277
• ServoNode 51 Installation Guide MN1285

Stop motion

Drive enable

Clear errors

Counter clockwise

Jog speed

Clockwise
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2.5.3 Macro Toolbar

Figure 6: Macro Toolbar

The         key displays the Assign Macros window:

The macro to be entered is selected by
clicking the radio button to the left of Mn.
(Where n is the number of the macro.)

The ToolTip text is configurable, and is
displayed when the mouse pointer dithers
over the selected macro toolbar button.
The Macro Text is entered here and may
span multiple lines.
Hitting Enter at the end of the macro
executes the command in the same way as
hitting enter after typing a Mint command at
the command line in the terminal window.
Missing out the Enter key will just place the
macro text on the command line in the
terminal window, but won’t execute it.

Figure 7: Assign Macros Window

Checking the Send ‘Break’ check box ensures the Mint Break command (Ctrl + E) is sent to the
controller before executing the macro.  This ensures the macro interrupts a program running on the
controller.

The remaining toolbar buttons simply trigger the macro commands.
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2.6 The QuickWatch Window
The QuickWatch window appears on the left-hand side of the WorkBench window by default, and
controls:

• The display of up to 4 controller parameters such as position or following error.
• Tuning
• Data capture

To remove the left-hand pane:
• Click the X Close Window button              or
• Click the toolbar button

2.6.1 The QuickWatch Tab
The QuickWatch pane is selected by pressing the QuickWatch tab, allowing up to 4 parameters to be
simultaneously displayed.

These include:
• Measured velocity
• Following Error
• Measured axis position
• DAC demand
• Demand position
• Demand velocity
• Mint Mode of motion
• Inputs
• Auxiliary encoder
• Auxiliary encoder velocity

To select a variable to watch, use the drop down to chose the
variable.  The axis number can also be selected.

Figure 8: QuickWatch window
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Once a variable is selected, the Mint WorkBench will interrogate the controller for data.  Altering
the ‘Time Between QuickWatch Samples’ can change how often Mint WorkBench asks for this
information.  The smallest value will set the quickest response time but this may affect the response
time of the terminal.  This will depend upon the speed of your PC.  Obviously, the faster the PC the
better.
The data can also be captured to a graph.  This is achieved by pressing the Capture button at the
bottom of the QuickWatch pane.  The amount of data, in seconds, is selected by changing the
sampling time in the QuickWatch pane.  This must be done before the Capture button is pressed.
The Mint WorkBench sends instructions to the controller to collect the data.  Once collected, this
will be displayed in a graph as shown in Figure 12.

2.6.2 Speed Loop Tab

The Speed Loop tab does not apply to all controllers.  Where not applicable, the Speed Loop
Tuning Parameters are grayed out, and clicking Start Move generates an error.

The Speed Loop tab is used to perform test moves for tuning.  Move data is captured and can be
uploaded from the controller using the Capture tab (see 2.6.4 Capture Tab).
The reader is referred to their controller manual for tuning details.

The Sampling Time displayed at the top of the window is
connected to the Time at speed listed in the test move details
at the bottom of the window.  The Sampling Time will always
be greater than the Time at speed to ensure the entire move is
captured.
Clicking the Start Move button performs the move and
capture.
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Figure 9: Speed Loop Tab

2.6.3 Position Loop Tab
The Position Loop tab is used to perform test moves for tuning.  Move data is captured and can be
uploaded from the controller using the Capture tab (see 2.6.4 Capture Tab).
The reader is referred to their controller manual for tuning details.

The controller axis selected using the Perform Move On Axis
pulldown.

Clicking the spin button         varies the Sampling Time.

The Move Type is selected using the Move Type pulldown:
• Position Step
• Position Trapezoid
• Position Sinusoid (currently unsupported.)

Move Distance, Slew Speed, Acceleration and Deceleration
are configurable for Trapezoidal moves.

Clicking the Start Move button performs the move and
capture.

Figure 10: Position Loop Tab
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2.6.4 Capture Tab
A software oscilloscope is available in the Mint WorkBench.  This works by sending an instruction
to the controller to collect the required data.  The controller will collect the data in its internal RAM
and upload the data to the Mint WorkBench for viewing, printing or saving.  There are two uses for
the oscilloscope:

1. Capturing data for monitoring such as axis position, velocity or following error.
2. Axis tuning, allowing control parameters to be altered and a step response or move to be

initiated and the results plotted for analysis.

Figure 11: Capture Tab

Selecting the Capture tab allows you to change properties such as color of the background and color
of the lines for each item of data. Although all four channels of the QuickWatch window are
captured, only two are displayed. The plot drop downs select the data to plot.  Changing selection
does not re-plot the data.
Data can be saved to a CSV file (comma separated variable) for inclusion into spreadsheet packages
such as Microsoft Excel using the File, Save As menu.  This can be viewed in a spreadsheet by
selecting Comma Separated Variable (typically has a .CSV file extension).  Saving the file will save
all four channels from the QuickWatch window.
Sections of the plot can be magnified by selecting the start point with a mouse click, dragging the
mouse to highlight the area to magnify whilst keeping the left button pressed, and releasing the left
button.  Pressing the right mouse button restores the original plot.
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Selecting Print from the File menu prints the plot.

For serial controllers, it is strongly recommended that the Baud rate of the serial port be set as
high as possible.  The recommended Baud rate on the RS232 port is 57,600 Baud.

Figure 12: Software Oscilloscope
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2.7 CAN Window

The reader is referred to the CAN Peripherals Hardware Guide (MN1255) for a full explanation
of CAN Networks.

Figure 13: CAN window with Nodes tab selected

The Viewing pull-down selects CANopen (CAN1) or Baldor CAN (CAN2).
The status and bus speed of the currently selected CAN bus are displayed adjacent to this.
The CAN Peripherals Hardware Guide (MN1255)  details the possible values displayed.
The Scan button interrogates the CAN bus selected for active nodes.
The Reset button performs a CAN bus reset of the currently selected CAN bus
The CAN Window comprises three selectable tabs:
• Events Monitors network for CAN events.
• Nodes Displays list of network nodes.
• Groups Displays network group information.
Each tab contains a list that may be sorted by clicking the column headings.  For example, clicking
the column heading labeled Description sorts Nodes alphabetically by description.
The CAN bus selected in the Viewing pull-down applies to all three tabs.  It is not possible to view
CAN1 events and then click the Nodes tab and view CAN2 nodes without first changing the
Viewing pull-down selection.



Mint WorkBench

  MN1283  08.2000 21

2.7.1 The Events tab

Figure 14: CAN window with Events tab selected

The Events tab displays a list of time-stamped CAN events, falling into a couple of categories: bus
status events and node events.

Indicates Node Live notification events, Indicates other events.
Right-clicking the mouse in the Events tab displays a popup menu containing the option Clear.
Clicking Clear removes the events displayed.

Figure 15: CAN window with right click Clear menu displayed

2.7.2 The Nodes Tab

Figure 16: CAN window with Nodes tab selected

The nodes tab contains a list of nodes specifying Live/Dead status, Node Number, Description,
Connection Master information and Group Information.
The column headed Connected lists the Node Numbers of controller nodes with which connections
exist.
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The Group Master column lists the Group Number of groups for which the node is groupmaster.
The Group Member column lists the Group Numbers of groups of which the current node is a
member.
Right-clicking the Network Manager node (Node Number=1) displays a popup menu containing the
option Inputs/Outputs.  Selecting Inputs/Outputs displays the Digital I/O window (see X.XX.)
The Digital I/O window may also displayed by:
• Select Tools, Digital IO Window or
• Click

Right clicking on a remote controller-node displays a grayed Inputs/Outputs menu, as Digital I/O
is unavailable on remote controller-nodes.
Digital I/O is available on other remote nodes only if connected to the Network Manager.
Attempting to display the Digital I/O window for a node that is not connected to the Network
Manager displays an error message.

For example: In the CAN window displayed above, right clicking the AnalogIn node would display:

Figure 17: Error message displayed when remote CAN node right clicked

This is remedied by entering the following at the terminal:
connect.1.5=1

The connection between the Network Manager (Node number=1) and the AnalogIn node (Node
number=5) should be updated in the Connected column of the Network Manager node:

Figure 18: CAN window with Nodes tab selected
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The CAN2 Nodes tab displays:

The Connected, Group Master and Group Member columns are not applicable to CAN2.
Again, the reader is referred to the CAN Peripherals Hardware Guide (MN1255)  for a full
explanation.

2.7.3 The Groups Tab
The Groups tab displays CAN Network groups, listing: Group number, Master Node number, and
Member node numbers.

Figure 19 CAN Window with Groups tab selected

Groups are configured at the terminal.  The screenshot above is the result of executing the following
Mint commands:

groupmaster.3=1
groupmaster.4=2
group.3.2=1
group.4.1=1

The Mint commands groupmaster and group always refer to CAN1, and so the Groups tab
remains blank for CAN2.

2.8 Terminal
The Terminal window provides access to the Mint command line.
To enable the Terminal Window:

• Select Tools, Terminal or
• Enter [Ctrl]+[T] or

• Click the  icon:
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Figure 20: Terminal window shown in context of WorkBench window

The terminal can be resized by dragging the border (please refer to your Windows user
documentation if you are unsure).
To check that you are communicating with the controller, select the terminal window and hit the
return/enter a key a few times.  The Mint command line prompt should appear if there is no program
running.  Type Crtl-E (or use ) to stop program execution if a program is executing.
If you have a multi-drop RS485 system, use the Tools, Select Controller menu to select the correct
controller.  You should now be able to communicate with the controller.
For those users familiar with Mint, the INS key will now put the terminal into overwrite mode.  In
overwrite mode the terminal sends the necessary key strokes when a key is pressed to insert the
character into the line.
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2.9 Editor

Figure 21: Full screen editor with syntax highlighting

A full screen editor is available with color syntax highlighting.  This means that Mint keywords,
numbers, strings and remarks (REM statements) are highlighted in different colors.  Features also
include cut and paste and full search and replace.
The editor is opened from the File menu.  A new file can be selected or an existing file can be
selected and opened.  Separate editors are supported for both the Mint program and Mint
configuration buffers.
There are several ways to initiate the editor:

• To create a new file, select File, New and then either Config or Program or Array.
• To open an existing file, select File, Open and then either Config or Program or Array.
• To upload a program, select File, Upload and then either Config or Program or Array.
• To download a program, select File, Download and then either Config or Program or

Array.
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Figure 22: The Open file window for selecting existing files for editing

To provide the default program name above with a name when saving, select File, Save As.
The standard Windows Cut (Ctrl-X), Copy (Ctrl-C) and Paste (Ctrl-V) functions are available both
on the toolbar and in the Edit menu.
Other editor functions include:

• Downloading the files to the controller by using the toolbar icon .  By using the Tools,
Setup Squash selection, files can be compressed on download (see the following section
for detail on squash).

• Uploading the files from the controller into the current menu using the toolbar icon .
WorkBench will automatically upload the correct file from the controller depending upon
which editor window is open.

• Ability for Mint files to be dragged from Windows Explorer onto the WorkBench desktop.
This will automatically open the editor.

• Printing from the editor using the Print icon  on the tool bar.  The file is printed to the
currently installed Windows printer.

The right mouse button can be used within the editor window to provide context sensitive menus.
The menu allows, for example:

• Search and replace.  This saves using the menu.
• All white space can be displayed.
• Selected text can be made upper or lower case.
• The properties of the editor can be changed, for example, the color of the keywords can be

changed from their default setting.
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Figure 23: Properties sheet for the Mint WorkBench Editor

The tabs on the properties sheet gives access to the following:
Color/Font: The default font the editor can be changed.  A mono spaced font should be selected

for Mint files.  The colors of keywords, numbers etc can be tailored to suit your
tastes.

Language/Tabs: Only one language is supported, Mint.  Always leave “Convert tabs to spaces while
typing” checked.

Keyboard: The default keyboard mappings can be changed to suit your taste.
Misc: Controls whether color highlighting is used; whether scroll bars are shown; size of

undo buffer etc.
All the settings are saved when the Mint WorkBench is closed down and will be available for the
next session.
For syntax and keyword highlighting, it may be necessary to synchronize the editor with the latest
version of Mint.  This can be achieved by selecting Edit, Load Syntax.  Updating the syntax should
be done every time you receive a new version of Mint or a new MintDrive.
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2.10 Squash
Squash allows a program to be compacted by removing redundant characters – blank lines for
example.  It is possible to save from an editor in the squashed format, or to have WorkBench Squash
each time it downloads a file.
Squash can perform several operations on a file.  However, some of them can make the code
unreadable.  Therefore, the options are individually selectable.
To initiate the Setup Squash Parameters dialog box, select Setup Squash from the Tools menu.

Figure 24: Setup Squash window

Whitespace removal section:
• Remove Indentation -  Clicking this check box removes spaces from the start of lines.
• Remove Spaces -  Clicking this check box removes any unnecessary spaces other than at

the start of a line.
• Remove REMs  - Clicking this check box removes all REM statements.
• Remove Blank Lines – Clicking this check box removes any blank lines.

Code compression section:
• Evaluate Constants – Clicking this check box replaces Mint constants with their numeric

values.  For example, it replaces _cfservo with 1.
• Abbreviate Keywords -  Clicking this check box replaces any longhand Mint keywords

with their two or three letter forms.
• Optimize Axis Strings -  Clicking this check box will replace any single axis statements in

the square bracket form with the dot form.  For example: MA[0] will be squashed to MA.0
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Selecting Squash on Download will always squash the program or configuration file on download.
This is useful where a fully commented file can be maintained on the PC, but a space saving file is
downloaded to the MintDrive for execution.

2.11 MintDrive Drive & Motor Parameters
The MintDrive Drive & Motor Parameters page, available from Tools, Drive & Motor Parameters
menu allows the drive stage of the MintDrive to be tuned.  The reader is referred to the MintDrive
Installation Manual (MN1274) for a full explanation.

2.12 Firmware Update

This option is not available on NextMove PCI.

For MintDrive, ServoNode 51 and other serial controllers, the Mint firmware is stored on Flash.
From time to time there may be updates to Mint, to either fix problems or to add new features.  It is
possible to update the Mint firmware using the RS232 serial port.

The RS485 port cannot be used for firmware update.

From the Tools menu, select Update Firmware and follow the onscreen instructions.

 Caution: The state of the analog and digital outputs cannot be guaranteed while
firmware is being updated.  Please disconnect any equipment that may be
damaged.

 Caution: It is recommended to remove any AUTO configuration file prior to
updating firmware.  Changes to the firmware may affect how your Mint
application will work.

 Caution: Updating firmware may destroy any program(s) held in the battery
backed-up RAM buffers.  It is recommended that you upload these into
Mint WorkBench if you require these to be saved.

 Caution: Updating firmware will destroy any program(s) held in the Flash memory
buffers.  It is recommended that you upload these into Mint WorkBench if
you require these to be saved.

Once the firmware has been updated, both the Config and Program Flash buffers will need resetting.
Typing the NEW command in each Flash buffer will do this.  The Mint keyword BUFFERSTORE can
be used to switch between battery backed-up RAM and Flash buffers.
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2.13 View Platform

The Platform Information window provides details of the number and type of axes, the number of
inputs/outputs and CAN channels.
To view the Platform Information window:

• Select View, Platform Information or
• Click the    icon:

2.14 Comms Window
The Comms window provides access the controller’s Comms locations.  Details are given in the
individual controller manual.
To view a Comms window:

• Select Tools, Comms Window
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Multiple Comms windows are obtained by making repeated selections of the option above.

The comms location is selected using the Comms Location pull-down.
The current value is updated by entering a new value in the edit box adjacent to the Write this value
button, and clicking it.

2.15 Digital I/O Window
The Digital I/O window displays the current state of the controller’s
digital inputs, outputs and if appropriate, relay.
To view the Digital IO window:

• Select Tools, Digital IO Window, or
• Click the     icon, or
• Right-click the controller in the CAN Window. (See 2.7

CAN Window)
The Outputs are clickable and display a green LED.  The Inputs
display a green LED as an indication of their state, but are not
clickable.

2.16 DPR WatchWindow
The DPR WatchWindow allows viewing and manipulation of the NextMove PCI’s onboard Dual-
Port RAM.
To view the DPR WatchWindow:

• Select Tools, DPR WatchWindow or
• Click the    icon:
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The reader is referred to the NextMove PCI Installation Manual (MN1277) for a detailed
explanation.

2.16.1 Custom Groups
Custom Groups allow frequently used DPR locations to be grouped and viewed together.
To create a Custom Group:

1. Right-click the mouse in the left-hand pane of the window.  Selecting New Group from the
popup menu displayed adds a new item: Custom Group to the list in the left-hand pane of the
window.

2. Right click Custom Group and select Rename from the popup menu to rename it.
3. Custom Group items are added by dragging from other DPR Groups.
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2.17 Log To File
The WorkBench will log serial traffic to disk.
To configure serial logging:
• Select Tools, Log to file

2.18 Update Bootloader

This option applies only to NextMove PCI. and should only be used under guidance from
technical support.

2.19 Keyword Lookup
Most Mint keywords have abbreviations that may be used in place of the full keyword:

Keyword Abbreviation

Node Nd
SerialBaud Sb

Pressing [F8] displays a Mint keyword lookup dialog:
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The user can select the keywords listed:
Mint Motion Keywords are commands such as mover, driveenable.
Mint Basic Keywords are commands such as loop, endl, dim, if.
Mint Constants are the expressions prefaced with an underscore displayed above.

The cursor begins in the keyword editbox under the keyword list.  As a keyword is typed here the
keyword list is searched and the closest matching keyword/abbreviation selected.
The “Copy Keyword” and “Copy Abbreviation” buttons copy the appropriate text to the Windows
clipboard for later use.
The dialog is closed using [Esc] or by using the “Close” button.

2.20 Serial Test
This is available from Tools-Test Serial Communications.  A dialog displays the test progress as
Controller->Computer and Computer->Controller communication is tested at different comm port
speeds.
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The recommended comm port speed is displayed following a successful test, and in the event of
failure the reason and speed as displayed:
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